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Before you begin

Before you use the NS/Router, you must verify that the NS/Router has been configured to 
connect to at least one AS/400 system.
If you attempt to use the NS/Router before it has been configured, you will not have a 
configuration file (*.RTR) to open and no available AS/400 systems with which to connect.
To configure the NS/Router and connect AS/400 systems, double-click on the NS/Router 
Configurator icon (located next to the NS/Router icon) shown below:



Required software versions

NS/Router requires the following software versions:

    Windows 3.1 or later
    Adapter interface software appropriate to your communications adapter
    NetWare for SAA version 1.3B running at your NetWare server. 



Fine print

Online Help copyright © 1993-1994 NetSoft.  All rights are reserved.

This Online Help may not, in whole or part, be copied, photocopied, reproduced, translated 
or reduced to other physical or electronic form without prior consent, in writing, from 
NetSoft, except as expressly provided for in the License Agreement.    Printing of Online 
Help topics is limited to fair use by licensed user(s) of this copy of NS/Router.

NS/Router is a trademark of NetSoft. All other company and product names are trademarks 
or registered trademarks of their respective holders.



A quick look at NS/Router

The NS/Router window is shown in the following diagram.

Select an area on the diagram by clicking on it with your mouse and information about that 
topic will be displayed. (You can also select an area using Tab and Enter on the keyboard).



Using the NS/Router Window

The NS/Router window consists of the following areas:

The title bar located at the top of the window.
The menu bar located directly underneath the title bar.
The message area, which is the left half of the window.
The active system links area, which is the bottom right quarter of the window.
The inactive system links area, which is the top right quarter of the window.
The status bar along the bottom of the window.



Overview of NS/Router

NetSoft's NS/Router is a windows-based router.
This program is menu-driven and allows you to:

    Start and Stop AS/400 Connections to AS/400 systems in four different ways.
    Start and Stop a Log File where all of the error and progress messages displayed in the 

NS/Router message window are written.
    Start and Stop a Trace File which traces send/receive frames.
    Start a Status Dump where the NS/Router dumps the memory from the APPC.DLL 

program.
    Force Offf AS/400 Systems with Active Sessions Attached.

Before you begin
Before you use the NS/Router, you must verify that the NS/Router has been configured to 
connect to at least one AS/400 system.
If you attempt to use the NS/Router before it has been configured, you will not have a 
configuration file (*.RTR) to open and no available AS/400 systems with which to connect.
To configure the NS/Router and connect AS/400 systems, double-click on the NS/Router 
Configurator icon (located next to the NS/Router icon) shown below:

NS/Router Window
The NS/Router window consists of the following areas:

The title bar located at the top of the window.
The menu bar located directly underneath the title bar.
The message area, which is the left half of the window.
The active system links area, which is the bottom right quarter of the window.
The inactive system links area, which is the top right quarter of the window.
The status bar along the bottom of the window.



Message Area

The message area displays all of error, status and progress messages that relate to the 
NS/Router's operation.



The Message Area
The message area, located in the left half of the NS/Router window, displays all progress 
and status messages relating to the NS/Router's operation.

The messages are color-coded for ease of identification. 

Color of Text Indicates
White Informational message.
Green System start up message.
Yellow Error message.

If you enable an NS/Router Log file (which would be indicated on the status bar at the 
bottom right of the window by "Log:On"), all progress and status messages are written to 
the log file with a date/time stamp prefix.

If your NS/Router configuration file (*.RTR) is open, the message area will indicate whether 
or not you have a successful connection.



Active System Links

Active AS/400 systems are depicted in the Active system area, located at the bottom right 
quarter of the NS/Router window, by a yellow system box containing the name of the 
AS/400 system. 

You can stop an active system by dragging the yellow system box from the active system 
area and dropping it into the inactive system area or by double-clicking on the yellow 
system box. You can also use the Router: Stop menu option.



Inactive System Links

Inactive AS/400 systems are depicted in the Inactive system area, located at the top right 
quarter of the NS/Router window, by a yellow system box containing the name of the 
AS/400 system. 

You can start an inactive system by dragging the yellow system box from the inactive 
system area and dropping it into the active system area or by double-clicking on the yellow
system box. You can also use the Router: Start menu option.



The Status Bar

The status bar is located at the bottom of the NS/Router window. The left half of the status 
bar indicates the current menu option function you are running. The right half of the status 
bar contains the four interactive indicator buttons. Their functions are listed below.

Current Menu Options Function
The left half of the status bar indicates the current menu option function that you are 
running (if any). For example, "Open an existing configuration file."

Interactive Indicator Buttons
The right half of the status bar contains four interactive indicator buttons. Their functions 
are listed below:

Link:Active/Inactive
Link:Active indicates that you have an active link to an AS/400 Host. Link:Inactive 
indicates that you do not have an active link to any AS/400 Host.

Force: Off/On
The default setting of Force: is Off. This means that you cannot inactivate individual 
systems with active sessions attached. When Force:On is active, you can inactivate any 
system, along with any active sessions attached, by dragging the yellow system box 
from the active system area to the inactive system area or vice versa. To toggle between
Force: Off and Force: On, double-click on the indicator button.
This indicator button coincides with the Force All Sessions to End check box located on 
the Router: Stop... menu option.

Trace: Off/On
The default setting is Trace:Off. To open and start a diagnostic trace file, where APPC 
communications and send/receive frames are written, double-click on the Trace:Off 



indicator button to toggle to Trace:On. You will be prompted to enter a filename for the 
trace file. The default trace filename is NSROUTER.TRC. Double-click on the Trace: On 
indicator button again to close the trace file.
This indicator button coincides with the File: Diagnostic...: Start/Stop Trace menu option.
If no router configuration file has been opened, this indicator button will be inactive.

Log: Off/On
The default setting is Log:Off. To open and start a diagnostic log file, where all of the 
progress messages in the client message area of the NS/Router window are written 
(including a time and date stamp in front of each message) double-click on the Log:Off 
indicator button to toggle to Log:On. You will be prompted to enter a filename for the log 
file. The default log filename is NSROUTER.LOG. Double-click on the Log: On indicator 
button again to close the log file. 
This indicator button coincides with the File: Diagnostic... Start/Stop Log    menu option.



Status Bar

The status bar displays messages relevant to the menu commands and indicator buttons.



Starting and Stopping AS/400 Connections

You can start or stop the NS/Router connection to an AS/400 system in one of four ways:

Router Menu

1. By clicking on the Router menu Start... option to start selected inactive system(s), or the 
Stop...    option to stop selected active system(s). 
NOTE: If you want to Stop systems that have active sessions attached, you must select 
the Force All Sessions to End check box.

2. By clicking on the Router menu Start All option to activate all inactive systems, or the 
Stop All option to inactivate all active systems (even those with active sessions 
attached).

NS/Router Window

3. By dragging the yellow AS/400 system box from the inactive system area to the active 
system area or vice versa. 

4. By double-clicking on any yellow AS/400 system box contained in the inactive system 
area to start the system, or by double-clicking on any yellow AS/400 system box 
contained in the active system area to stop the system.



File Menu Options

The Open... menu option displays a File Open dialog box. Type the filename of the 
NS/Router configuration file (*.RTR) you want to use or select a filename from the list box. 
Choose "OK" to start the NS/Router. If another NS/Router configuration file was open, it is 
closed and the specified file is opened. The title bar of the NS/Router window changes to 
show the filename of the current NS/Router configuration file.
The Diagnostics menu option displays a cascading menu with three options: Log Start, 
Status Dump and Trace Start. These options are used for troubleshooting communications. 
The options toggle from Start to Stop as the current mode of the diagnostics change. 

The Log Start... option is used to log all of the messages displayed in the message area 
to a disk file, with a time and date stamp in front of each message. Once you specify a 
log filename, the Log box in the status bar changes to indicate that message logging is 
enabled. The menu option changes to Log Stop which is used to close the log file and 
stop the logging of messages.
The Status Dump... option is used to create a memory dump of the APPC DLL used for 
communications with the AS/400. Once you specify a dump filename, the memory dump 
is written to the dump file. If no router configuration file has been opened, this menu 
option is dimmed (unavailable).
The Trace Start... option is used to log the APPC communications to a disk file. Once you 
specify a trace filename, the Trace box in the status bar changes to indicate that the 
trace is enabled. The menu option changes to Trace Stop which is used to close the trace
file and stop the logging of APPC communications. If no router configuration file has been
opened, this menu option is dimmed (unavailable).

The Exit menu option is used to exit the NS/Router. If any systems are active, you will be 
prompted to verify that you want to close them and exit. All currently open files are closed, 
including log, trace, dump and NS/Router configuration files. The keyboard shortcut: for exit
is Alt+F4.



Router Menu Options
The options on the Router menu are used to start and stop configured AS/400 systems. In 
order to select any of the Router menu options, you must first open an NS/Router 
configuration file (*.RTR) using the File Open... option. NS/Router configuration files are 
created and saved using the NS/Router Configurator and must contain at at least one 
AS/400 system.

    If no NS/Router configuration file has been opened, all Router menu options are dimmed 
(unavailable) and cannot be selected.

    If an NS/Router configuration file has been opened, but no systems have been started
(activated), the Start... and Start All options are available and the Stop... and Stop All options
are dimmed (unavailable) and cannot be selected.

    If an NS/Router configuration file has been opened and all systems it defines are 
started (activated), the Stop... and Stop All options are available and the Start... and Start All
options are dimmed (unavailable) and cannot be selected.

    If an NS/Router configuration file has been opened and some systems it defines are 
started and some are inactive, all Router menu options are available.

Start...
The Start... Router menu option is used to start selected AS/400 system(s). 

Start All
The Start All Router menu option is used to start all inactive AS/400 systems at once. 

Stop...
The Stop... Router menu option is used to stop selected AS/400 system(s). 

Stop All
The Stop All Router menu option is used to stop all active AS/400 systems at once.



Start System

The Start... Router menu option is used to start selected AS/400 system(s). When you 
select Start..., a list box containing all inactive AS/400 systems in your NS/Router 
configuration file is displayed. If a default system was configured, it will be marked with 
(default). 

    To select a single system, click on the system name with the mouse. (Keyboard: Tab 
to highlight and Space Bar to select).

    To select consecutive systems, shift-click on the system names. (Keyboard: Tab to 
highlight and Shift Up/Down Arrow to select).

    To select several non-consecutive systems, control-click on the system names.

Choose OK to start the selected system(s). You will be prompted to enter a password for 
each system that is started. If this password is the same for all subsequent systems, you 
will not be prompted again. If the password is different for each system, you will be 
prompted for each subsequent system. You will also be prompted to enter a Common User 
ID if you did not enter this in your NS/Router Configuration file. Choose Cancel to exit out of
the dialog box without starting any systems.

An alternate way to start systems one at a time using the yellow system boxes displayed in
the NS/Router window, is to either drag and drop the yellow system box from the inactive 
window area to the active window area or double-click on each inactive yellow system box.



Stop System

The Stop... Router menu option is used to stop selected AS/400 system(s). When you select
Stop..., a list box containing all active AS/400 systems in your NS/Router configuration file is
displayed. If a default system was configured, it will be marked with (default). 

    To select a single system, click on the system name with the mouse. (Keyboard: Tab 
to highlight and Space Bar to select).

    To select consecutive systems, shift-click on the system names. (Keyboard: Tab to 
highlight and Shift Up/Down Arrow to select).

    To select several non-consecutive systems, control-click on the system names.

Choose OK to stop the selected system(s). Choose Cancel to exit out of the dialog box 
without stopping any systems.

An alternate way to stop systems one at a time using the yellow system boxes displayed in 
the NS/Router window, is to either drag and drop the yellow system box from the active 
window area to the inactive window area or double-click on each active yellow system box.

The Force All Sessions to End check box is not selected by default. This means that you 
cannot inactive (stop) any systems which have active sessions attached. If you select this 
check box, you can then stop any active system along with any active sessions attached. 
This check box coincides with the Force:Off/On indicator button located on the NS/Router 
window status bar.



Start All Systems

The Start All Router menu option is used to start all inactive AS/400 systems at once. When
you select Start All, all inactive AS/400 systems in your NS/Router configuration file are 
started. You will be prompted to enter a password for the first system that is started (the 
default system if you specified one). If this password is the same for all subsequent 
systems, you will not be prompted again. If the password is different for each system, you 
will be prompted for each subsequent system. You will also be prompted to enter a 
Common User ID if you did not enter this in your NS/Router Configuration file. 

If one or more connections to two or more systems fail to connect or no Default system is 
configured, the first successfully connected AS/400 becomes the Default system.

You can automate this process by re-configuring your NS/Router Configuration file. From the
NS/Router Configuration window, open your NS/Router Configuration file and select the 
Preferences... button. Select the Automatically Start All Systems check box. Save your 
NS/Router Configuration file. Go to the NS/Router window and open your re-configured 
NS/Router Configuration file using the File menu Open option. All of the AS/400 systems will
start automatically. You will still be prompted for a password.



Stop All Systems

Stop All
The Stop All Router menu option is used to stop all active AS/400 systems at once. When 
you select Stop All, all active AS/400 systems in your NS/Router Configuration file are 
stopped, regardless of whether or not they have active sessions attached. You will not be 
prompted for an OK on each individual system.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Contents Offers you an index to topics on which you can get 
help.

Search for Help 
on 

Allows you to search for a help topic by typing a 
word in a text box or selecting a word from a list 
box.

How to Use Help Provides general instructions on using help.
About... Displays the version number and other information 

for the NS/Router.



Help Contents command (Help menu)
Use this command to display the opening screen of Help.

From the opening screen you can access step-by-step instructions for using NS/Router and 
various types of reference information by clicking on any underlined word or topic. For 
example, the Quick Look... topic accesses an overview of the main NS/Router screen.

Once you are within the Help system you can click on:

    any underlined word or topic for reference information pertaining to that word or 
topic.

    the Contents button whenever you want to return to the opening screen.

    the Search button to access Help's index facility.

    the    Back button to return to the previous topic.

If you are a novice at using Window's help, use the Help: Using Help menu option for 
detailed instructions on using Help.



How to Use Help command (Help menu)

Use this command for detailed instructions on using Help.



Search for Help On Command (Help menu)

Use this command to display the Search dialog box where you can type a word in the text 
box or select a word from the list box. 
After you have selected the word, click on Show Topics and all of the topics related to the 
word are displayed. 
Highlight the topic you are interested in and click on the Go To button to display help 
information on that topic.



About command (Help menu)

Use this command to display the copyright notice, version number and other information 
about your copy of the NS/Router.



Common User ID Dialog Box

This dialog box prompts you for your Common User ID/ password. The Common User ID is a
ten-character field. The password is a ten-character field and each keystroke will be 
represented by an asterisk (*) for security reasons.

Select OK to sign on to the AS/400 with the specified Common User ID/password. Select 
Cancel to exit out of the dialog box without specifying a Common User ID or password.



System User ID Dialog Box
This dialog box prompts you for your user System UserID/password. The System User ID is 
a ten-character field. The password is a ten-character field and each keystroke will be 
represented by an asterisk (*) for security reasons.

Select OK to sign on to the AS/400 with the specified System User ID. Select Cancel to exit 
out of the dialog box without specifying a System User ID/password.



Start All Systems Dialog Box
This dialog box allows you to start all inactive AS/400 systems at once. When you select 
Start All, all inactive AS/400 systems in your NS/Router configuration file are started. You 
will be prompted to enter a password for the first system that is started (the default system
if you specified one). If this password is the same for all subsequent systems, you will not 
be prompted again. If the password is different for each system, you will be prompted for 
each subsequent system. You will also be prompted to enter a Common User ID if you did 
not enter this in your NS/Router Configuration file. 

If one or more connections to two or more systems fail to connect or no Default system is 
configured, the first successfully connected AS/400 becomes the Default system.

You can automate this process by re-configuring your NS/Router Configuration file. From the
NS/Router Configuration window, open your NS/Router Configuration file and select the 
Preferences... button. Select the Automatically Start All Systems check box. Save your 
NS/Router Configuration file. Go to the NS/Router window and open your re-configured 
NS/Rotuer Configuration file using the File menu Open option. All of the AS/400 systems will
start automatically. You will still be prompted for a password.



Start System Dialog Box
This dialog box allows you to start selected AS/400 system(s) by selecting them from a list 
box containing all of the inactive AS/400 systems in your NS/Router configuration file. If a 
default system was configured, it will be marked with (default).

    Select a single system, click on the system name with the mouse. (Keyboard: Tab to 
highlight and Space Bar to select).

    To select consecutive systems, shift-click on the system names. (Keyboard: Tab to 
highlight and Shift Up/Down Arrow to select).

    To select several non-consecutive systems, control-click on the system names.

Choose OK to start the selected system(s). You will be prompted to enter a password for 
each system that is started. You will also be prompted to enter a Common User ID if you did
not enter this in your NS/Router Configuration file. Choose Cancel to exit out of the dialog 
box without starting any systems. 

An alternate way to start systems one at a time using the yellow system boxes displayed in
the NS/Router window, is to either drag and drop the yellow system box from the inactive 
window area to the active window area or double-click on each inactive yellow system box.



Stop System Dialog Box
This dialog box allows you to stop active AS/400 system(s) by selecting them from a list.

    Click with the mouse to select a single system. (Keyboard: Tab to highlight and Space 
Bar to select).

    Shift-click to select consecutive systems. (Keyboard: Tab to highlight and Shift 
Up/Down Arrow to select).

    Control-click to select several individual systems.

Choose OK to stop the selected system(s). Choose Cancel to exit out of the dialog box 
without stopping any systems.

Force all sessions to end
The "Force all sessions to end" check box allows you to inactivate any system, even though 
active sessions are connected to that system. This check box coincides with the 
"Force:Off/On" indicator button on the status bar.



Stop All Systems Dialog Box

This dialog box allows you to stop all active AS/400 systems at once. When you select Stop 
All, all active AS/400 systems in your NS/Router configuration file are stopped, regardless of
whether or not they have active sessions attached. You will not be prompted for an OK on 
each individual system.



Open Configuration Dialog Box

This dialog box is used to open an NS/Router configuration file (.RTR) for use by the 
NS/Router. NS/Router configuration files are created and saved using the NS/Router 
Configurator. For information on NS/Router configuration, use the online Help in the 
NS/Router Configurator program.

Select the NS/Router configuration file from the list box. Choose OK to open the specified 
NS/Router configuration file. Choose Cancel to exit out of the dialog box without opening an
NS/Router configuration file.



Start Trace Dialog Box

This dialog box is used to start a trace file and to specify the filename to use for the trace 
file.

Type the name of the trace file in the text box or select a filename from the list box. Choose
OK to open the specified trace file and begin the trace. Choose Cancel to exit out of the 
dialog box without opening a trace file.

This dialog box coincides with the "Trace:Off/On" indicator button on the status bar.



Start Log Dialog Box

This dialog box is used to start a log file and to specify the filename to use for the message 
log file.

Type the name of the log file in the text box or select a filename from the list box. Choose 
OK to open the specified log file and begin logging the messages. Choose Cancel to exit out
of the dialog box without opening a log file.

This dialog box coincides with the "Log:Off/On" indicator button on the status bar.



Status Dump Dialog Box

This dialog box is used to start a status dump file and to specify the filename to use for the 
status dump file.

Type the name of the status dump file in the text box or select a filename from the list box. 
Choose OK to open the specified dump file and perform the status dump. Choose Cancel to 
exit out of the dialog box without opening a dump file.



Title Bar

The title bar shows the name of the current open NS/Router configuration file (*.RTR). If 
there is no currently open file, the title bar reflects Untitled.



Menu Bar

The menu bar groups commands into categories. 



The Menu Bar

The Menu Bar groups commands into categories. The categories for the NS/Router windows
are as follows:

File Menu Options
The Open... menu option.
The Diagnostics menu option displays a cascading menu with three options. 

The Log Start/Stop... option.
The Status Dump... option.
The Trace Start/Stop... option.
These options are used for troubleshooting communications. The options toggle from 
Start to Stop as the current mode of the diagnostics change. 

The Exit menu option is used to exit the NS/Router. All currently open files are closed, 
including log, trace, dump and NS/Router configuration files.

Router Menu Options
The options on the Router menu are used to start and stop configured AS/400 systems. 
The Start... option.
The Start All option.
The Stop... option.
The Stop All option.

Help Menu Options
The options on the Help menu are used to access help information on various topics.
The Contents option.
The Search for Help on  option.
The How to Use Help  option.
The About...  option.



Error and Status Messages

This section includes error and status messages for the NS/Router. These messages are 
listed first by link driver name and then by the module name as typically used in the error 
message. Click on the specific topic or module name that you would like to view.

Link Driver Names
NetWare for SAA Link Driver Error and Status Messages
NS/Router Error and Status Code Messages
Common NS/Router Communications Status Messages
API Error and Status Messages



NetWare for SAA Link Error and Status Messages

The following messages appear in Windows message boxes:

The Router cannot load the EHNRTRW.DLL library! Please make sure that this library is 
available and try the Router again.

Cause: Displays when you start the Router and the library EHNRTRW.DLL cannot be 
found.

Action: Make sure that the EHNRTRW.DLL library is available. If you have deleted this 
library, you must re-install the product in order to retrieve the library.

Cannot find EHNAPPC.DLL entry points! Verify that you have the correct library and try the 
Router again.

Cause: Displayed when the Router loads the EHNAPPC.DLL library, but cannot find 
callable entry points within the library.          You may not have the correct version of this
library available in Windows if you inadvertently deleted the NetSoft version (which 
was copied at installation time), or you mistakenly installed the IBM version.

Action: Make sure that the NetSoft version of the EHNAPPC.DLL library is available in 
Windows. If you have deleted the NetSoft version, you must re-install the product in 
order to retrieve the library.

Cannot find EHNRTRW.DLL entry points!    Verify that you have the correct library and try 
the Router again.

Cause: Displayed when the Router loads the EHNRTRW.DLL library, but cannot find 
callable entry points within the library.          You may not have the correct version of this
library available in Windows if you inadvertently deleted the NetSoft version (which 
was copied at installation time), or you mistakenly installed the IBM version.

Action: Make sure that the NetSoft version of the EHNRTRW.DLL library is available in 
Windows. If you have deleted the NetSoft version, you must re-install the product in 
order to retrieve the library.

The Router cannot locate the MPXBX.DLL* library!
Cause: This library is missing from the Elite/400 directory.
Action: Verify that this library is available in the Elite/400 directory, and try running the 

NS/Router again.

Cannot find MPXBX.DLL entry points!
Cause: Occurs when you have an incompatible router and APPC DLL.
Action: Verify that you have the correct library version and try the Router again.

The following messages appear in the client message area of the Router
frame window:

EHNAPPC.DLL initialization failed: x



Cause: Displayed when the initialization call to the EHNAPPC.DLL library is made and 
fails where x can equal 85 Library Load Failure or 86 Library Not Initialized. This is a 
terminal error.

Action: Call NetSoft Customer Support and report the error.The x in the message is an 
error code that was returned by Windows and must be relayed to NetSoft Customer 
Support

EHNRTRW.DLL initialization failed: x
Cause: Displayed when the initialization call to the EHNRTRW.DLL library is made and 

fails where x can equal 85 Library Load Failure or 86 Library Not Initialized. This is a 
terminal error.

Action: Call NetSoft Customer Support and report the error message.The x in the 
message is an error code that was returned by Windows and must be relayed to 
NetSoft Customer Support.

Cannot load MPXBX.DLL: n
Cause: Displayed when the Router cannot load the MPXBX.DLL library.
Action: Normally this message is preceded by a Windows error message indicating that 

the MPXBX.DLL library cannot be located. In this case, make sure that the MPXBX.DLL 
library is available in your Elite/400 installation directory. If the MPXBX.DLL library was 
inadvertently deleted after installation, you must re-install the product to retrieve the 
library.

If this message is displayed without the Windows error message, then it is a terminal 
condition and you should call NetSoft Customer Support and report the error message. 
The n at the end of the error message is an error code that was returned by Windows and
must be relayed to NetSoft Customer Support.

Cannot load MPVBX.DLL: n
Cause: Displayed when the Router cannot load the MPVBX.DLL library.
Action: Normally this message is preceded by a Windows error message indicating that 

the MPVBX.DLL library cannot be located. In this case, make sure that the MPVBX.DLL 
library is available in your Elite/400 installation directory. If the MPVBX.DLL library was 
inadvertently deleted after installation, you must re-install the product to retrieve the 
library.

If this message is displayed without the Windows error message, then it is a terminal 
condition and you should call NetSoft Customer Support and report the error message. 
The n at the end of the error message is an error code that was returned by Windows and
must be relayed to NetSoft Customer Support.

Cannot retrieve adapter address: n
Cause: Displayed when the Router is configured for token ring, the adapter's address 

has been specified as the Local LU name and there has been a problem getting the 
adapter's address. Where n can be any of the following: 

1 Interrupt SC Not Installed
2 Adapter Not Installed
3 Cannot Initialize Adapter
4 Global DOS Allocate Error.
Action:    If this message is displayed without the Windows error message, then it is a 



terminal condition and you should call NetSoft Customer Support and report the error 
message. The n at the end of the error message is an error code that was returned by 
Windows and must be relayed to NetSoft Customer Support.

System start failed: n
Cause: Displayed when starting an AS/400 system through the Netware for SAA 

communications server. A possible cause, for example, might be that the 802.2 TR 
address configured in the router configuration file (.RTR) does not match the TR 
address of the AS/400 to which the SAA communications server is connected. An 
unrecoverable failure has occurred. Where n can equal: 

6E System Not In Configured System List
6F Communication Error With the Server
70 System Not Connected Yet
71 Internal Error from MPVBX
Any return code over 100 means the error return code from different TLI functions. The 
high order byte of return code indicates which TLI call originated the error.
Action: Verify that the TR address configured matches the AS/400 TR address. Attempt 

to start the system again. If further problems are encountered, call NetSoft Customer 
Support. The n at the end of the error message is an error code that was returned by 
the system and must be relayed to NetSoft Customer Support.

Link not established: nn
Cause: Displayed when starting an AS/400 system through the NetWare for SAA 

communications server. An unrecoverable failure has occurred. Where nn can equal: 
66 - Timeout in Searching Novell Server
Action: Attempt to start the system again. If further problems are encountered, call 

NetSoft Customer Support. The nn at the end of the error message is an error code 
that was returned by the system and must be relayed to NetSoft Customer Support.

67 - Novell Server Not Found
Cause:    The Netware for SAA Communications server could not be found on the 

network.
Action: 1) Verify that windows is running in 386 enhanced mode. 2) Verify that VIPX.386 

is on the network= line in the [386enh] section of the system.ini file 3) Verify that 
VIPX.386 exists and is WINUP7 or later 4) Verify that IPX (or IPXODI) is DOSUP7 or later

68 - Error in Allocating Memory
Action: Attempt to start the system again. If further problems are encountered, call 

NetSoft Customer Support. The %X at the end of the error message is an error code 
that was returned by the system and must be relayed to NetSoft Customer Support.

69 - Can't Initialize Connection to Server
Action: Attempt to start the system again. If further problems are encountered, call 

NetSoft Customer Support. The nn at the end of the error message is an error code 
that was returned by the system and must be relayed to NetSoft Customer Support.

6A - Can't Activate Connection to Server
Action: Attempt to start the system again. If further problems are encountered, call 

NetSoft Customer Support. The nn at the end of the error message is an error code 
that was returned by the system and must be relayed to NetSoft Customer Support.

6B - Fail to Connect the Server.
Action: Attempt to start the system again. If further problems are encountered, call 



NetSoft Customer Support. The nn at the end of the error message is an error code 
that was returned by the system and must be relayed to NetSoft Customer Support.

1D0 - Duplicate or Invalid Location name
Cause:    The specified location name is probably already in use by another user.
Action: Change your location name, or delete the device corresponding to your location 

name on the AS/400.

Disconnect Physical failure: %X
Cause: Displayed when stopping an AS/400 system through the NetWare for SAA 

communications server. An unrecoverable failure has occurred. Where %X can equal: 
8C Fail to Disconnect the Server
8D Can't Deactivate Connection to Server
8E Can't Free Server's Overheads.
Action: Attempt to stop the system again. If further problems are encountered, call 

NetSoft Customer Support. The %X at the end of the error message is an error code 
that was returned by the system and must be relayed to NetSoft Customer Support.



NS/Router Error and Status Messages

PCS-Compatible router found!
Cause: Occurs when you install the NS/Router and another PCS-Compatible router is also

present.
Action: If you choose to install, configure and use the NetSoft NS/Router, it is not 

recommended that you use another router (such as the IBM PCS router or the Novell 
router) at the same time. For example, if you install the NS/Router and the Novell 
Router and change the Router Type in the Session Manager: Set Global Options to IBM 
PCS-Compatible and then attempt to switch between them, you may encounter error 
messages and unpredictable behavior. If you choose to use a router other than the 
NS/Router, you must go to the Session Manager: and select the Set Global Options 
button and change the Router Type from NS/Router to IBM PCS-Compatible.

Invalid APPC Code Pointer
Cause: Occurs if an invalid APPC library module (such as MPXBX.DLL) is used with the 

Router, or if there has been a previous GFP error involving the MPXBX.DLL
Action: Reset your PC. If the problem recurs, call NetSoft Customer Support.

Link Terminated By Host
Cause: Occurs when the AS/400 disconnect timer expires and there are no active 

emulation sessions or this can be caused by an error state on the AS/400. The host will
then drop the link and all systems will then be in an inactive state.

Action: Verify that all physical connections are complete and that no error states exist. 
The desired AS/400 system must be restarted after the physical connection is made.

An error occurred while creating the Status Dump!
Cause: Various causes.
Action: Try creating a new Status Dump file.

Configuration file is not found.
Cause: You are trying to open a configuration file in the Router program and the name 

you designated either does not exist or is located in a another directory.
Action: Verify in the Router Configurator that the configuration file exists, and check the 

path and extension.

A previous instance of the Elite/400 Router is already active!
Cause: The NS/Router is already running.
Action: No action necessary.

An error occurred while starting the trace!
Cause: Various causes.
Action: Try creating a new Trace file.

An error occurred when trying to stop the trace.



Cause: Various causes.
Action: Try stopping the Trace file again.

Cannot stop system with active sessions.
Cause: Occurs when an active session is running and you try to stop the system.
Action: You can either close the active session or force the system off by clicking the 

"Force: Off" indicator button in the Router Window or checking the "Force: Off" 
checkbox in the "Stop All" list box.

An APPC error has occurred.
Cause:    This message occurs on the Router Status line and is followed by several 

messages as detailed in the "Common Status File Code Messages" section described 
later in this chapter.

Action: See the "Common Status Code Messages" section.

Initializing APPC DLL
Cause: Status message in the Router status line.
Action: No action necessary.

APPC DLL not initialized. Error nn.
Cause: A file open error has been encountered, where nn is the hex error code. This can 

be caused by a bad file name, an incorrect path designation,    a corrupted file, lack of 
sufficient memory and so forth.

Error Description
Code
64h Error in reading or opening an .rtr file (router configuration)
65h Error in reading or opening a translation file
Action: Verify the file name and path that you are tring to read or open. Verify that the 

file is not corrupted.

Sense data `XXXXXXXX.'
Cause: Occurs when you have the "Common Status Code Messages" followed by the 

above message which indicates the AS/400 is sending sense data.
Action: Call NetSoft Customer Support.

Waiting for host reply
Cause: Status message.
Action: No action necessary.

Link not established.
Cause: Occurs when the link cannot be completed.
Action: Verify that the host and NS/Router configurations are correct and that the 

physical link has been made.

Link established.



Cause: Status message, indicating that the NS/Router has successfully linked your PC to 
the host.

Action: No action necessary.

Link terminated.
Cause: Status message, occurs when you bring down the last system.
Action: No action necessary

Starting x router
Cause: Where x represents the link driver you specified in the router configuration file. 

This status message occurs when you are attempting to link with the first AS/400 
system.

Action: No action necessary.

Starting system x
Cause: Where x represents the host system name. Status message, indicated the 

system is starting.
Action: No action necessary.

System x User ID x started.
Cause: Status message indicating the AS/400 System assigned to the User ID has 

started.
Action: No action necessary.

System x stopped.
Cause: You have stopped a system via the Router menu "Stop" option.
Action: No action necessary.

APPC Configuration terminated.
Cause: Occurs when you are loading a new configuration and a previous configuration 

file has been opened.
Action: No action necessary.



Common NS/Router Error and Status Messages

PCS-Compatible router found!
Cause: Occurs when you install the NS/Router and another PCS-Compatible router is also

present.
Action: If you choose to install, configure and use the NetSoft NS/Router, it is not 

recommended that you use another router (such as the IBM PCS router or the Novell 
router) at the same time. For example, if you install the NS/Router and the Novell 
Router and change the Router Type in the Session Manager: Set Global Options to IBM 
PCS-Compatible and then attempt to switch between them, you may encounter error 
messages and unpredictable behavior. If you choose to use a router other than the 
NS/Router, you must go to the Session Manager: and select the Set Global Options 
button and change the Router Type from NS/Router to IBM PCS-Compatible.

Cannot complete action on system
Cause: This message occurs when you can't start or stop the system.
Action: Verify the status code messages below. If you receive a different message, 

contact NetSoft Customer Support. Common status code messages are displayed in 
the following format:

"Status Code:xxxx-xxxx-xxxxxxxx".
where the first two characters are the APPC verb, the second four characters the primary

return code and the last eight characters are the secondary return code.

[Status Code: 4600-0014-00000000]
Cause: Usually occurs when the configuration is not correct or the physical link cannot 

be made, but can occur in other instances, too.
Action: Verify settings for the link driver in the Router Configurator program and host 

configuration.

[Status Code: 1500-0003-000000004]
Cause: Usually occurs when the configured System Name being started was not found, 

but can occur in other instances, too.
Action: Verify the System Name and retry the operation.

[Status Code: 0C00-0001-080F60J1]
Cause: Usually occurs when an invalid system password is entered, but can occur in 

other instances, too.
Action: Verify the correct password and retry the operation.

[Status Code: 0100-0003-00000005]
Cause: Allocation error.    Probably an incorrect system name, net ID, or location name.
Action: Check with your AS/400 system administrator to verify these    parameters.



Starting and Stopping a Log File

Use the File: Diagnostics: Log Start menu option to start a log file which will write any 
messages that are displayed in the message area to a log file name, together with a time 
and date stamp in front of each message. 

The Start/Stop Log dialog box will be displayed for you to specify the filename to use for the
message log file.

Type the name of the log file in the text box or select a filename from the list box. Choose 
OK to open the specified log file and begin logging the messages. Choose Cancel to exit out
of the dialog box without opening a log file.

The default filename is NSROUTER.LOG. The default directory is where NS/Router is located.
The list of file types are *.log and *.* When you select a Router configuration file, you will 
return to the Router window where the status bar indicates you are in a Logging mode, and 
the File Menu option then toggles to Log Stop. 
The Log Stop option is used to close the log file, stop logging messages and save the log 
file. The File Menu option toggles back to Log Start.

This dialog box coincides with the "Log:Off/On" indicator button on the status bar.



Starting a Status Dump

Use the File: Diagnostics: Status Dump menu option to start a status dump file where the 
NS/Router dumps the memory from the APPC.DLL program.

The Status Dump dialog box will be displayed for you to specify the filename to use for the 
status dump file.

Type the name of the status dump file in the text box or select a filename from the list box. 
Choose OK to open the specified status dump file. Choose Cancel to exit out of the dialog 
box without opening a status dump file.

The default filename is NSROUTER.DMP. The default directory is where NS/Router is located.
The list of file types are *.dmp and *.*.



Starting and Stopping a Trace File

Use the File: Diagnostics: Trace Start menu option to start a trace file which will start 
tracing send/receive frames to the trace file you specify.

The Start Trace dialog box will be displayed for you to specify the filename to use for the 
trace file.

Type the name of the trace file in the text box or select a filename from the list box. Choose
OK to open the specified trace file and begin tracing send/receive frames. Choose Cancel to
exit out of the dialog box without opening a trace file.

The default filename is NSROUTER.TRC. The default directory is where NS/Router is located.
The list of file types are *.trc and *.* When you select a Router configuration file, you will 
return to the Router window where the status bar indicates you are in a Trace mode, and 
the File Menu option then toggles to Trace Stop. 
The Trace Stop option is used to close the trace file, stop tracing frames and save the trace 
file. The File Menu option toggles back to Trace Start.

This dialog box coincides with the "Trace:Off/On" indicator button on the status bar.



Force AS/400 Systems Off

You can stop AS/400 systems that have active sessions attached by using the Router: 
Stop... menu option and selecting the Force All Sessions to End check box or you can use 
the Force: Off interactive indicator button on the status bar as shown below:

The default setting of the Force: indicator button is Off. This means that you cannot 
inactivate individual systems with active sessions attached. When Force: On is active, you 
can inactivate any system, along with any active sessions attached, by dragging the yellow
system box from the active system area to the inactive system area or vice versa. To toggle
between Force: Off and Force: On, double-click on the indicator button.

This indicator button coincides with the Force All Sessions to End check box located on the 
Router: Stop... menu option.

NOTE: When you use the Router: Stop All menu option, all systems are stopped, even 
systems with active sessions attached.



Help Button

Choose this button to receive help information pertaining to the current screen.



API Error and Status Messages

[API1] : PCS Router and/or PCSWIN compatibility program not found.
Cause: You attempt to configure or start a session and the IBM PCS router has not been 

loaded.
Action: You must first load the router then configure or start the session. You must also 

ensure that PCSWIN.EXE is in the Windows directory or    your directory path.

[API2] : Maximum number of APPC sessions reached.
Cause: You attempt to configure more than 32 sessions.
Action: The maximum number of sessions that can be configured is 32.

[API3] : Unable to allocate memory for APPC function call.
Cause: This message is displayed when there is not enough memory.
Action: Free up more memory by closing one or more active Windows applications.

[API4] : DPMI error occurred during APPC function call.
Cause: This is a terminal error.
Action: Contact the NetSoft Support department .

[API5] : Bad translate table parameter.
Cause: You probably have a corrupted or invalid translation table.
Action: You can re-install the product in order to refresh the table or call NetSoft 

Customer Support

[API6] : PCS Router program not found.
Cause: IBM PCS Compatible router may not have been started; emulator may have been

configured and tried to connect to invalid router type.
Action: Verify which router is running -- check the Session Manager "Set Global Options" 

window for correct Router Type. If the message displays again, contact NetSoft 
Customer Support.

[API6] : NS/Router program not found.
Cause: NS/Router may not have been started; emulator may have been configured and 

tried to connect to invalid router type.
Action: Verify which router is running -- check the Session Manager "Set Global Options" 

window for correct Router Type. If the message displays again, contact NetSoft 
Customer Support.

[API7] : PCSWIN or NSAWIN compatibility programs not found.
Cause: Either the PCSWIN TSR (when using IBM PCS compatible router) or the NSAWIN 

TSR (when using the NS/Router) has been loaded.
Action: Load the appropriate TSR.



[API8] : NSAWIN buffer size smaller than specified INI size.
Cause: This message is displayed when the NSAWIN buffer size is smaller than the 

CONVBUFFSIZE= parameter (located in the e400.INI file under the [Display] section).
Action: The NSAWIN command line buffer size must be equal to or greater than the 

E400.INI file CONVBUFFSIZE= parameter. Either edit the file so that command line is 
equal to or greater than the CONVBUFFSIZE parameter, or re-install the product. If this 
does not work, call the NetSoft Support department.

[API9] : MPXBX.DLL library load error.
Cause: This message is displayed when the router has been unloaded (or a possible 

timeout) and you try to connect an existing session to the router.
Action: Disconnect the session, reload or restart the router and then start the session. If 

the message displays again, contact NetSoft Customer Support.

[API10] : MPXBX.DLL Initialize APPC not called.
Cause: This message is displayed when you try to start a session before you have 

loaded and started the router.
Action: Load the router and verify that it is active, then start the session. If the message

displays again, contact NetSoft Customer Support.

[API11] : System specified or no system started.
Cause: Router may not have been started; system specified or no system started; 

routing system may have been disconnected (possibly a timeout).
Action: Verify router and system have been started, then restart the session. If the 

message displays again, contact NetSoft Customer Support.

[API12] : NS/Router or router configuration file not found.
Cause: You attempt to configure or start a session and the NS/Router has not been 

loaded or a router configuration file (default *.RTR) has not been loaded.
Action: You must first verify that the NS/Router has been loaded and that a router 

configuration file has been created and loaded; then configure or start the session.

[API12] : IBM PCS Compatible Router not found.
Cause: You attempt to configure or start a session and the IBM PCS compatible router 

has not been loaded.
Action: You must first load the router and then configure or start the session.




